|
| - L |
| PlayStation |
Je

if
&

2
i

ion

PlayStat

2
£
£

E|

A
L

2

L PlayStation |

Entertainment International Ltd, 580 Catfo
@ 2000 Entertainment Internat

Licensed by Sony Computer Eil
registered trademarks of Sony Compusi &

Manufactured and printed in the U.S.A. THIS SOFTWARE 5 Cuiwi Al i6LE WiTh |

DESIGNATION. U.S. AND FOREIGN PATENTS PENDING.

i
|

ion

(i PlayStat

]
| Bt
!

ion

.

PlayStat

Iy Take 2.

y/Siation logos are
o Ligial Software Association
LAYSTATIGN GAME CONSOLES WITH THE NTSC U/C

[

NTSC |U/C

CONTENT RATED BY
ESRB

SLUS-01261
01261

- |
| PlayStation

tNTERBACTIVE
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A very small percentage of individuals may experience epileptic seizures when exposed to certain light
patterns or flashing lights. Exposure to certain patterns or backgrounds on a television screen or while
playing video games, including games played on the PlayStation game console, may induce an
epileptic seizure in these individuals. Certain conditions may induce previously undetected epileptic
symptoms even in persons who have no history of prior seizures or epilepsy. If you, or anyone in your
family, has an epileptic condition, consult your physician prior to playing. If you experience any of the
following symptoms while playing a video game — dizziness, altered vision, eye or muscle twitches,
loss of awareness, disorientation, any involuntary movement, or convulsions — IMMEDIATELY
discontinue use and consult your physician before resuming play.

WARNING TO OWNERS OF PROJECTION TELEVISIONS:

Do not connect your PlayStation game console to a projection TV without first consulting the user
manual for your projection TV, unless it is of the LCD type. Otherwise, it may permanently damage
your TV screen.

USE OF UNOFFICIAL PRODUCT:
The use of unofficial products and peripherials may damage your PlayStation game console and
invalidate your console warranty.

HANDLING YOUR PLAYSTATION DISC:

« This compact disc is intended for use only with the PlayStation game console.

« Do not bend it, crush it or submerge it in liquids

« Do not leave it in direct sunlight or near a radiator or other source of heat.

* Be sure to take an occasional rest break during extended play.

+ Keep this compact disc clean. Always hold the disc by the edges and keep it in its protective case
when not in use. Clean the disc with a lint-free, soft, dry cloth, wiping in straight lines from center to
outer edge. Never use solvents or abrasive cleaners.
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) GETTING STARTED

GETTING STARTED

To play Pro Pinball: Fantastic Journey on

your Console:

1. Set up your Console in accordance

with its instruction manual.

2.  Following your system’s directions,
insert your Fantastic Journey disc

(printed side up) in the drive.

3. Close the disc cover and press the

POWER button to begin loading the

simulation.

NOTE: We advise that you do not insert
or remove peripherals (controllers, etc.)
from your Console while it is

switched on.

First you will be presented with the

Language Select screen. Highlight your

Top View “

RESET BUTTON ———— ‘ ;

prefered language and press X or
START to confirm. Then some logo
screens are displayed, followed by the
Fantastic Journey table backbox. From the
backbox, you can load the table and play

 peeron | 8ames, or use the Options menu.
[

POWER INDICATOR ——————— |
POWER BUTTON ———————
CONTROLLER PORT - -

L osccown Press the LEFT and RIGHT

Directional buttons on the

Front View

=\ :
CONTROLLER PORT 1 —é \:j
CONTROLLER PORT 2 ——————o—————— |

MEMORY CARD SLOT 1
L MEMORY CARD SLOT2

controller to highlight the
options. Press the X button to

make your selection.

DUALSHOCK™ analog controller

L2 BUTTON
L1 BUTTON

DIRECTIONAL BUTTONS

LEFT STICK
SELECT BUTTON
ANALOG MODE SWITCH ———

START BUTTON

RIGHT STICK

NOTE: Compatible only in Digital and Analog mode
or
Compatible only in Digital and Vibration mode
or
Compatible only in Digital mode

NOTE: You may have a controller that looks like this,

if so please follow the digital instructions outlined above.

R2 BUTTON
R1BUTTON

/\ BUTTON
O BUTTON
X BUTTON
[0 BUTTON




QUICKSTART

To start playing Fantastic Journey, select

the Table icon from the table backbox.

DEFAULT CONTROLS

The default buttons used to control
Fantastic Journey are as listed below, but
you can change these to buttons you
prefer (see page 25).

O Start new game; or add extra
player, up to four players

X Launch ball into play

A Activates MagnoSave™ when lit

:d)]?iztioml Activates the Left flipper

button

O Activates the Right flipper

L2 Nudge the left of the table

R2 Nudge the right of the table

Lt or R1  Nudge the table upwards

START Pause Game (in-game options)

LEFT STICK/

RIGHT STICK push the Left/Right stick to
nudge the table up, down,
left and right. (Only
available in Analog Mode
(LED:Red)

HIGH-SCORE INITIALS ENTRY - use

the left and right flipper buttons to select
a letter or character, then press the Launch
button to enter the selected letter or
character. To back up one character, select
and enter the €= character. You can enter
up to three characters; select the final —
character to enter the initials into the

High-Score Table.

OPTIONS

At the backbox, select the Sliding Bar Icon
to use the simulation’s Options Menu. If
you have a memory card in your system,
you can save all Option settings on to it so
that they will automatically be used as the
starting Options when you next run
Fantastic Journey (see the Memory Card
section on page 28).

Use the UP, DOWN, LEFT, and RIGHT
Directional buttons to highlight options,

and X to confirm selections.

During a game, Sound Volume options are
also available on the Pause Menu (see
pages 30 and 31).

The Options menu items are described

below.
LANGUAGE

Use this Option to select the language for

all Options and menus.

o

TABLE VIEW

Use this Option to select your preferred
viewing angle of the table from the three
Fantastic Journey table views available, shown
in the small graphics at the bottom of the
screen. The main graphic shows a larger
version of the selected view. Gameplay is
identical regardless of the view.

CONTROLS

Use this Option to change the buttons

which control Fantastic Journey.

Highlight "Change Controls" and press X
to select, or press A go back.

While each control action is highlighted,
press the button you want to assign (use)
to perform that action. Press START
during selection to keep or reassign the
previous button(s) assigned to that action.
You can assign a second button to the

same action by holding down the first

button whilst pressing the second button.



Be careful not to accidentally assign the

same button to two different actions.

Use the Restore Default Controls
menu selection to restore all the default

buttons.

VIBRATION

NOTE: This Option will only appear if
a DUALSHOCK™ analog controller is
plugged into Controller Port 1.

Choose Enabled or Disabled.

If you want to use your DUALSHOCK™
analog controller for nudging, press the
Analog Mode Switch on the Controller
and make sure the LED is Red.

GRAPHICS
The Graphics Options are described

below.

FOCUS - Choose Soft or Sharp focus for
the graphical display. If you notice flicker
on your display, choosing Soft focus

should reduce it.

DOT MATRIX - The Fantastic Journey dot
matrix display (DMD) shows the current
score, is used to play video modes, and
provides additional information during

gameplay.
You can choose a DMD which is

Solid—with no table features showing
through, or Transparent—so you can see
the ball while it’s moving behind the
DMD.

DOT MATRIX POSITION - Choose Low,

Medium, or High to set the position of

the dot matrix display on your screen.

AUDIO

Audio output is an integral part of
Fantastic Journey gameplay and Dolby

Surround Sound is used throughout.
The Audio Options are described below.

TEST MECHANICAL SOUND / TEST SPEECH AND SFX /
TEST MUSIC - Use these Options to choose a
test Fantastic Journey game sound from
each category. Each selected test sound
plays repeatedly until you switch it Off.
You then use the Volume Controls to

adjust the levels of each type of sound to

your personal taste.

VOLUME CONTROLS - Use these Options to set
your preferred volume levels for each
category of Fantastic Journey game
sounds. Note that you won’t hear any
sounds unless you use the Test settings
described above to choose and play test

sounds.

MODE - Choose one of Mono, Stereo, and
Swapped Stereo settings. Choose Swapped
Stereo if the flipper sounds play on the

wrong speaker.



MEMORY CARD

NOTE: You must use MEMORY CARD
SLOT 1 for your MEMORY CARD.
Please make sure you have enough free
blocks on your memory card before
commencing play.

If your MEMORY CARD is new, you
must format it before you first use it.
Fantastic Journey automatically detects this
if you try to Save Options on to an
unformatted MEMORY CARD.

To format a MEMORY CARUD, select the
Memory Card menu, then select the Save
option. This displays the Format menu.
Select YES to format your MEMORY
CARD or NO to return to the Memory

Card menu.

AUTO SAVE - Choose Enabled or Disabled.
When Enabled, Options and high-scores
will automatically be saved to your
MEMORY CARD.

LOAD - Loads Option settings and high-
scores from the MEMORY CARD. You
can also use this Option to load data from
another MEMORY CARD.

SAVE - Saves Option settings and high-
scores to the MEMORY CARD.

EXAMINE TABLE

Use this Option to see the incredible
detail within the Fantastic Journey
playfield in extreme close-up.

Press the Directional buttons to move, the
X button to zoom in, and or the
SELECT button to zoom out.

TABLE RULES

Use this Option to view the rules card on
the Fantastic Journey table, which gives an

outline of the basic rules of gameplay.

This is by no means an exhaustive list of
all the aspects of the game, and there are
many hidden features and modes that you
will only discover by practice and
repeated play.

SLIDESHOW

Use this Option to view a slide show tour
of the Fantastic Journey playfield in close-
up, clockwise from the bottom left of the
table. This will help you to understand and
learn the playfield layout.

Press the X button to see the next slide
in the show; the show continues looping
until you exit by pressing or the

SELECT button.

CREDITS / START SIMULATION

Self-explanatory.



PAUSE MENU
(IN-GAME OPTIONS)

Pressing the Pause Game button (START
button) during gameplay pauses the game
in progress and displays the Pause Menu,
which allows you to change some game
Options, use the Operator menus, or
adjust the position of the graphical display
on your screen.

You can also use the Pause Game button
(START button) during Attract Mode
(when no game is in progress).

Use the UP, DOWN, LEFT, and
RIGHT Directional buttons to highlight
options, and X to confirm selections.
The individual Pause Menu items are

described below.

RETURN T SIMULATION

Continues the game in progress, or

resumes Attract Mode.

START NEW GAME / ADD
PLAYER / RESTART GAME

During a game, this Option changes as

appropriate.

START NEW GAME / RESTART GAME - Starts a

new game. Any game in progress is

immediately abandoned.

ADD PLAYER - Adds a new player to the game
in progress, up to a maximum of four. This
must be done before the final player’s Ball

1 drains (goes out of play).

DIFFICULTY LEVEL

Sets one of five preset game difficulty
levels from Extra Easy to Extra Hard, or a
Custom game difficulty setup which you
have previously created by altering
Adjustment settings using the

Operator’s Menu.

TABLE SETUP

SLOPE Sets the angle of the table slope, in
half-degree steps from four degrees to

eight degrees.

The higher the angle, the faster the ball

will travel down the table.

CONDITION Sets the condition of the table,
from New to Neglected.

A clean new table does not spin the ball as
much as an older neglected table; so on a
new table, the ball tends to slide more and
travel faster. Playfield rubbers and
mechanics are also less powerful on more
neglected tables.

FLIPPERS POWER - Sets the power levels of all
flippers. Note that increasing flipper power
will not necessarily make the gameplay

any easier.

ACTIVATE OPERATOR'S
MENU

NOTE: Selecting this item abandons any
game in progress.

Enters the Operator’s Menu system on the
dot matrix display. The Operator’s Menu
System is described in detail on page 20 of

this manual.

EXIT GPERATOR’S MENU

(only displayed while Operator’s
Menu is active)
Exits the Operator’s Menu system and

resets the table to Attract Mode.

ABJUST VOLUME

Sets the volume levels of game sounds

and music.

ADJUST SCREEN POSITION

Sets the position of the display on

your screen.



QuIT TO BPTIONS

Abandons the game in progress (if any)
and displays the Options menu
(see page 25).

WORLD WIDE
HIGH-SCORES TABLE

Empire Interactive maintains a World Wide
High-Scores Table for Fantastic Journey
on its Web site at http://www.empire-
interactive.com/propinball/
Fantasticjourney.

The finest pinball players in the world
post their high-scores to this Table, and
former world championship players feature
in the current Pro Pinball: The Web, Pro
Pinball: Timeshock! and Pro Pinball: Big
Race USA High Score Tables.

How to Enter a Score in the Table

Once your high scoring game has ended,

12

press and hold both Flipper Buttons for at
least two seconds.

This displays the high-score code for the
game just played.

Make a careful note of your high-score
code because the World Wide High-Scores
Table will ignore invalid codes.

On your next visit to the World Wide
High-Scores Table, type in your name and
your code. The Table will update
automatically.

FEEDBACK

Cunning Developments, the Pro Pinball
development team, welcomes all
comments and bug reports you may have;
please send these to us by e-mail to
FJ@propinball.com. We do read all the
messages sent to us, but we cannot
guarantee a personal response.

CUNNING DEVELOPMENTS

Direction and Design

Adrian Barritt
Graphics Graham Rice
Programming Champie
Programming Adrian Page
Graphics Tom Beesley

David M Smith

Cai Remrod

Design Consultant
Design Consultant
Programming David Hunt
Produced by Adrian Barritt and Roger

Cheung

THE SPECIALISTS

MusIC BY
BACKGLASS ARTWORK
VOICE ARTIST

JoN Lowe
PETER RICHARDSON
ADAM LONGWORTH

SPEECH ENGINEERING PETER KIELY

TECHNICAL SUPPORT

If you need technical assistance with this product, call us
at
410 933 9191, Monday through Friday,

Eastern Standard Time.

Dolby and the double-D symbol are registered
trademarks of Dolby Laboratories Licensing Corporation

Pro Pinball is a registered trademark of Entertainment
International (UK) Ltd.

Cunning Developments is a registered trademark of
Entertainment International (UK) Ltd.
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PLAY TESTING

Stuart Dobbs
Clint Lee Masterson

David Woo

EMPIRE INTERACTIVE

Production
Artwork and Design

Head of QA,
Customer Services
and IT

Lead Tester

Quality Assurance

A.J. Bond

Phil Goldfinch
Nicolas Croc
Paul Flewitt
Jamie Young

Mike Holton
John Murray
Darren Thompson
lain Riches

Carlo Bush

Ben Etheridge
Bina Pawar

[an Goddard
Danny Jacobs

Fantastic Journey is a registered trademark of
Entertainment International (UK) Led.

Published by Empire Interactive.



FROM HIS MYSTERIOUS ISLAND,

General Yagov is holding the world to ransom.

If his demands aren’t met he will launch a
rocket to destroy the Moon, wreaking havoc and disaster

on a scale never before seen.

UNFORTUNATELY

nobody is able to penetrate the bizarre shield
which protects the Island.
Nobody that is, but Professor Steam!
By building four amazing steam powered contraptions,
and going on four fantastic adventures he can collect
four special crystals which will form a device

that will penetrate the shield!

ONLY YOU.

can help the Professor
to build the contraptions, collect the crystals,
penetrate the shield, stop the General and

save the World!

14

WELCOME T0 FANTASTIC JOURNEY,
the fourth in the PRO PINBALL series of
pinball machine simulation programs. As
pinball machine owners ourselves, the aim
of everyone on the PRO PINBALL team
is to bring you the closest experience
possible to actually owning and playing an
arcade pinball machine, without the
distractions of scrolling or split screens.
Though the default Fantastic Journey
machine settings have been carefully
chosen to give balanced gameplay, you can
fine tune the machine to suit your
preferences and playing style. You can even
examine the machine’s audit information
and adjust the difficulty of individual
features exactly as you would on a real
machine. We sincerely believe that you'll

find the playfield design, mechanics, music,

features, sound effects, depth of rules,
animations, operator menu, and gameplay
in Fantastic Journey are truly the equal of
a typical modern pinball machine. The
major differences are that you don’t have
to find house room for the machine, there
is zero maintenance, and it only costs one
per cent of the price of the real thing to
own! Those of you who already own our
earlier simulations can rest assured that
Fantastic Journey is even better than its
predecessors. You will discover many new
playfield mechanics and features to enjoy,
even better graphics and physics realism,
real airballs, and much more. We hope
you enjoy playing Fantastic Journey, if you
have an Internet connection, you can visit
the PRO PINBALL website at

http://www.propinball.com.
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10.
11.
12.
13.

. Left Flipper

. Left Sling Shot

. Left Inlane

. Left Outlane

. Left Plunger Lane
. MagnoSave™

. Dinosaur

. Left Bank Drop Targets

Left Orbit

Left Orbit Drop Targets
Left X2 Target

Left Ramp

Right X2 Target

. Jet Bank Drop Targets
. Jet Bumpers

. Octopus

. Bonus Rollovers

. MagnoBoost™

. Spinner Drop Target

20.

2

g

23.
24.
25.
26.
27.
28.
29.
30.
3.
32.

33

Spinner

. Spinner Lane

22.

Left Combo Target

Right Ramp

Right Combo Target

Left Boiler
Right Boiler
Contraption
Right Orbit
MagnoGrab™
Dead End
Yeti

Right Plunger Lane

. Ball Rescue
34.
35,
36.
37.
38.

Right Outlane
Right Inlane
Right Sling Shot
Right Flipper

Anaconda

i B
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e
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Build four amazing steam powered
contraptions and collect four special
crystals, to stop General Yagov from taking

over the world!

BONUS X - Complete rollovers to

advance Bonus X

LUCK - Complete L-U-C-K to light
Dead End for Luck. Shoot lit Dead End

for random Award.

STEAM MODES - shoot either Ramp to

light left Boiler for Steam Mode. Shoot lit

Boiler to start Mode.

ULTRA MODES - Complete H-E-R drop

targets to start a random Ultra Mode.

CONTRAPTIONS - Shoot ALL flashing

arrow shots to collect a part of a

Contraption. Collect three parts of the

5o RO TOPLAY FANTASTIC JOURNES

same Contraption to light right Boiler for
Adventure. Shoot lit right Boiler to start

and Adventure.

ADVENTORES - shoot the spinner to

increase steam pressure. Adventures stop
Wh‘;‘n steam pressurc reachcs Zero.
Complete adventures by making flashing

arrow shots in sequence.

STEAM FRENZY - Knock down three

drop targets on the left orbit to light lock
on the left orbit. Lock three balls to start
frenzy. Shoot right orbit to light Jackpot,
lock balls under ramps to multiply Jackpot

value.

THE MYSTERIDUS ISLAND - wWhen anl

four Adventures have been completed
shoot the right Boiler to start a raid on

the Mysterious Island!



1. SKILL SHOT, BONUS X, AND LUCK
SKILL SHOT - shoot random flashing drop

target (1 or 2) from ball launch for big
points and to complete
G-A-T-H-E-R.

BONUS X - Complete rollover targets (3
and 4) to advance Bonus X (5)

LOCK - Complete L-U-C-K (6) to light
Dead End for Luck. Shoot lit Dead End (7)
to activate MagnoGrab™ and collect

random Award.

2. STEAM MODES

Shoot either Ramp (1 or 2) to light Left
Boiler (3) for Steam Mode. Shoot lit Boiler

to award Mode.

VIDED MODE - A mysterious video mode.

Use the flipper buttons for control.

MEGA GATHER - Automatically gathers all

parts required to complete the currently

selected contraption.

FAST FRENZY - Shoot Left Orbit (4) to

add other balls into play. Shoot either Ramp
(1 or 2) to light Jackpot on Spinner (5).

BLOW THE BOILER - Spinner drop target

(5) is always up for MagnoBoost™. Shoot
spinner to increase Steam Pressure. Increase
Steam Pressure to blow the Boiler and score

big points.

SUPER BALL RESCUE - Activates Right

Outlane (6) saver until the end of ball.




MYSTERY JETS - Righe Orbit (1) always
feeds the Jets (2). A mystery shot
somewhere on the table collects current

mode total.

LIGHT OUTLANES - Lights the Outlanes

(3) for Extra Ball.

STEAM MANIA - Every switch scores

big points. Complete lit combo shots to

increase big points value.

DOUBLE PLAYFIELD - An scoring is
doubled.

DROP CHALLENGE - shoot the drop

targets (4,5) in order from left to right for

massive points.

LIGHT EXTRA BALL - Lighes Boiler

Scoop (6) for Extra Ball.

SUPER MAGNOSAVE™ _ Enables the left

outlane (7) saver until the end of the ball.
20

3. CONTRAPTIONS AND ADVENTURES
CONTRAPTIONS - shoot ALL flashing

arrow shots to collect a part of a

Contraption. Collect three parts of the same
Contraption to light Right Boiler (1) for

Adventure.

ADVENTURES - shoot Spinner (2) to keep

steam pressure high. If Steam Pressure
reaches zero the Adventure will stop. During
adventure shoot all flashing arrow shots to
advance the adventure. Complete adventure

to collect one of the four special crystals.



DRILL ADVENTURE - Drill to the Center

of the Earth. Avoid the General’s tanks and
take on a Fire Breathing Dinosaur (2).
Spray the Dinosaur with water to get past

him and collect the Crystal.

AIRSHIP ABVENTURE - Fly to the
Highest Mountain. Avoid the General’s bi-
planes and take on the Yeti (2). Bomb the
Yeti and collect the Crystal.

SUBMARINE ADVENTURE - Dive to the

bottom of the Deepest Ocean. Penetrate the
General’s mine field and take on a Giant
Octopus (3). Drag the Octopus to its doom
and collect the Crystal.

BOAT ADVENTURE - Journey to the

unexplored reaches of the Amazon. Avoid
the General’s battleships and take on a
Massive Anaconda (4). Harpoon the

Anaconda and collect the Crystal.

22

4. STEAM FRENZY
STEAM FRENZY - knock down all three

drop targets on the Left Orbit (1) to light
Lock on the Left Orbit. Lock three balls in
Left Plunger (2) to start Steam Frenzy.

Shoot Right Orbit (3) to light Jackpot on
Spinner (4). Lock balls under Ramps (5) to
enable Double and Triple Jackpots.

Score a Triple Jackpot to go for Super
Jackpot. Collect Super Jackpot by shooting
the Left Orbit.



5. ULTRA AWARDS

Complete H-E-R bank of targets (1) to start

a random Ultra Rounds (2).

ULTRA JETS - Shoot the Jets (3) for
Ultra Points

ULTRA SPINNER - shoot the Spinner (4)

for Ultra Points

ULTRA RAMPS - shoot the Ramps (5) for

Ultra Points

ULTRA DROPS - shoot the Drops (6,1) for

Ultra Points

ULTRA EVERYTHING - shoot Anything

and Everything for Ultra Points

6. MAGNOSAVE™ AND BALL RESCUE

Complete G-A-T bank of drop targets (1) to
light MagnoSave™ (2) and Ball Rescue (3)

MAGNOSAVE™ _ When lic and a ball is

heading for Left Outlane, press the
MagnoSave™ button to activate magnet

above Left Inlane.

BALL RESCUE - when lit, will

automatically propel balls heading down the

Right Outlane back into play.



1. COMBO SEQUENCE, DOUBLE SEQUENCE
AND LEFT RAMP SEQUENCE

COMBO SE““ENCE - Shoot targets (1,2)

to temporarily light Combo on the Right
Ramp (3). Then shoot the following shots in
sequence, Left Ramp (4), Right Orbit(5),
Left Orbit (6), Dead End (7). Each shot

gives bonus awards and big points.

DOUBLE SEQUENCE - shoot Right Ramp
consecutively to double award value and
light collect on Right Orbit. Shoot lit Right
Orbit to collect double award value and
send ball into Jets (13).

LEFT RAMP SEQUENCE - shoot Left
Ramp (4) repeatedly to activate
MagnoBoost™ (8), light Hold Bonus (9)
and light Extra Ball (10). Shoot side targets
(11,12) to double value of Ramp.

8. THE MYSTERIOUS ISLAND

Collect all four crystals (1-4) from the
Adventures to enable raid on the
Mysterious Island. Shoot Right Boiler (5)

to start the raid.

During raid activate all four contraptions by
shooting flashing arrows. Once all four
contraptions are in place, the shield can
finally be breached.

27



MENU SYSTEM

Fantastic Journey uses a Menu System to control all operator features. The

Main Menu contains five main categories, which lead to further lists of
options. All categories and options use military numbering.

To enter the Menu System, select the "Activate Operator's Menu" option from
the pause menu (see pages 30 and 31). The display shows the first Main
Menu category, 1. Book Keeping. The number and name of each successive
Tower level' category and option shows on the display as it is selected.

To cycle through the Main Menu categories, press the LEFT and RIGHT
Directional buttons.

To select a category and proceed to the next lower list of categories or
options, press the X Button.

To return to the next higher menu level, press the UP Directional button.
To select or activate any option or test, press the X Button.

To cycle through the current option adjustment values or test types, press
the LEFT and RIGHT Directional buttons.

To return to Attract Mode, navigate to the Main Menu categories, then press

the UP Directional button.

WARRANTY

Empire Interactive warrants to the purchaser only that the disc
provided with this manual and the software program coded on
it will perform in accordance with the description in this
manual when used with the specified equipment, for a period
of 90 days from the date of purchase.

If this program is found to be defective within 90 days of
purchase, it will be replaced. Simply return the disc to Empire
Interactive or its authorized dealer along with a dated proof of
purchase. Replacement of the disc, free of charge to the
original purchaser (except for the cost of returning the disc) is
the full extent of our lability.

THIS WARRANTY IS IN LIEU OF ALL
OTHER WARRANTIES, WHETHER ORAL OR
WRITTEN, EXPRESSED OR IMPLIED. ALL
IMPLIED WARRANTIES, INCLUDING THOSE OF
MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE, IF APPLICABLE ARE
LIMITED IN DURATION TO 90 DAYS FROM THE
DATE OF PURCHASE OF THIS PRODUCT.

Empire Interactive shall not be liable for incidental and/or
consequential damages for the breach of any express or
implied warranty including damage to property and, to the
extent permitted by the law, damages for personal injury, even
if Empire Interactive has been advised of the possibility of
such damages. Some states do not allow the exclusion or
limitation of any incidental or consequential damages or
limitations on how long an implied warranty lasts, so the

above limitations or exclusions may not apply to you.

This warranty shall not be applicable to the extent that any
provision of this warranty is prohibited by any federal, state, or
municipal law, which cannot be pre-empted. This warranty
gives you specific legal rights and you may also have other
rights, which may vary from state to state.

You may not reproduce, prepare derivative works based on,
distribute copies of, offer for sale, sell, transfer ownership of,
rent, lease, or lend to others the program or accompanying
documentation, or any portion or component of the program
or accompanying documentation; provided, however, that
you may transfer the entire program and accompanying
documentation on a permanent basis as long as you retain no
copies (including archival or backup copies) of the program,
accompanying documentation, or any p(miml or component
of the program or accompanying documentation, and the
recipient agrees to the terms of the agreement. Further, you
may not modify, reverse engineer, disassemble, decompile or
translate the program or accompanying documentation, or any
portion or component of the program or accompanying
documentation, nor may you make any copies of the program
modules for use with other programs. This program is

intended for private use only.

EMPIRE INTERACTIVE

580 CALIFORNIA STREET, 16th FLOOR,,

SAN FRANCISCO, CA 94104

ESRB RATING

This product has been rated by the Entertainment Software
Ratings Board. For information about the ESRB rating, or to
comment about the appropriateness of the rating, please
contact the ESRB at 1-800-771-3772.
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